
U
SER

G
U

ID
E

Prepared by:
Nick Marsh

Version 1.1
November 2003

www.toolkit.net.au/rap



 
 

River Analysis Package - 
Users Guide 

 

 
 
 

Prepared by 
Nick Marsh 

 
 

Software Version 
V1.0.1 

 
 

Date 
31-Jan-2004 

 

 

   



  Contents 

Document History 

Date Author Revision Description of Change 
07/11/03 Nick Marsh 1.0 Draft Text 
30/01/04 Nick Marsh 1.1 Updated Draft Text 
    
    

Copyright notice 

© CRC for Catchment Hydrology, Australia 2004 

Legal Information 

To the extend permitted by law, the CRC for Catchment Hydrology (including its employees and 
consultants) accepts no responsibility and excludes all liability whatsoever in respect of any person's use or 
reliance on this publication or any part of it 

   ii



   

Acknowledgements 

Scientific development 

Nick Marsh, CRC for Catchment Hydrology, Centre For Riverine Landscapes, Griffith 
University, Nathan 

Michael Stewardson, CRC for Catchment Hydrology, University of Melbourne 

Mark Kennard, CRC for Freshwater Ecology, Centre For Riverine Landscapes, Griffith 
University, Nathan 

Angela Arthington, CRC for Freshwater Ecology, Centre For Riverine Landscapes, Griffith 
University, Nathan 

Leon Metzeling, Victorian Environmental Protection Agency 

Bradley Pusey, CRC for Freshwater Ecology, Centre For Riverine Landscapes, Griffith 
University, Nathan 

 

Code Development 

Nick Marsh, CRC for Catchment Hydrology, Centre For Riverine Landscapes, Griffith 
University, Nathan  

Daniel Bennett, CRC for Catchment Hydrology, University of Melbourne 

David Verrelli, CRC for Catchment Hydrology, University of Melbourne 

Sylvain Arene, CRC for Catchment Hydrology, Centre For Riverine Landscapes, Griffith 
University, Nathan 

Shane Seaton, CRC for Catchment Hydrology, CSIRO, Canberra 

Joel Rahman, CRC for Catchment Hydrology, CSIRO, Canberra 

Nick Murray, CRC for Catchment Hydrology, CSIRO, Canberra 

 

Beta Testing 

Trevor Pickett, CRC for Catchment Hydrology, Centre For Riverine Landscapes, Griffith 
University, Nathan 

Jon Marshall, Queensland Department of Natural Resources and Mines 

Deborah Woods, CRC for Catchment Hydrology, University of Melbourne 

 

   





  Contents 

River analysis Package 

CONTENTS 

1 Introduction ......................................................1 

1.1 Hydraulic Analysis (HA) .......................................................................1 
1.2 Time Series Analysis (TSA)...................................................................1 
1.3 The user guide .....................................................................................1 
1.4 River Analysis Package .......................................................................2 

1.4.1 Overview .............................................................................2 
Hydraulic Analysis (HA) Module .........................................2 
Time Series Analysis (TSA) module .....................................2 

1.4.2 Features ..............................................................................2 
Hydraulic Analysis (HA) ......................................................2 
Time Series Analysis (TSA) ..................................................3 

1.4.3 Audience .............................................................................3 
1.5 Data requirements ..............................................................................4 

1.5.1 Input data ...........................................................................4 
Time Series Analysis (TSA) ..................................................4 
Hydraulic Analysis (HA) ......................................................4 

1.5.2 Output data.........................................................................5 
1.6 Product components ............................................................................5 
1.7 References and training ......................................................................5 

2 Installation........................................................6 

2.1 Technical specifications .......................................................................6 
2.2 Distribution media...............................................................................7 
2.3 Licence agreement ..............................................................................7 
2.4 Folders .................................................................................................7 
2.5 Installation...........................................................................................7 

2.5.1 Framework Installation.......................................................7 
2.5.2 Stand-alone PC ...................................................................7 

2.6 User Interface ......................................................................................8 
2.6.1 Start Menu icons..................................................................9 
2.6.2 Screens or dialogs...............................................................9 
2.6.3 Mouse & keyboard controls ................................................9 
2.6.4 Manual configuration .........................................................9 

2.7 Uninstalling RAP..................................................................................9 

   i



River Analysis Package - Users Guide   

3 Using RAP ....................................................... 10 

3.1 Getting started.................................................................................. 10 
3.2 How to Run HA (quickstart)............................................................... 11 
3.3 How to run TSA (quickstart) .............................................................. 12 

4 Hydraulic Analysis Module............................. 13 

4.1 Input Section Data ............................................................................ 13 
4.2 Hydraulic model................................................................................ 14 
4.3 Water Levels...................................................................................... 15 
4.4 Rule Library....................................................................................... 16 
4.5 Rating Curves .................................................................................... 17 
4.6 Time Series Export............................................................................. 18 

5 Time Series Analysis....................................... 19 

5.1 Input .................................................................................................. 19 
5.2 Reporting Period............................................................................... 20 
5.3 General Summary statistics .............................................................. 20 

5.3.1 Summary........................................................................... 21 
Minimum Daily Flow ......................................................... 21 
Maximum flow .................................................................. 21 
Q10 ................................................................................... 21 
Q90 ................................................................................... 21 
Mean daily Flow ............................................................... 21 
Median Daily Flow............................................................ 22 

5.3.2 Distribution....................................................................... 22 
Coefficient of Variation of Daily Flow............................... 22 
Standard Deviation of Daily Flow .................................... 22 
Skewness of Daily Flow .................................................... 22 
Variability of Daily Flow ................................................... 22 
Range of Daily Flows ........................................................ 23 
Standard deviation of the log of daily flows (S_Log) ....... 23 
Lanes variability index (Lanes) ........................................ 23 

5.3.3 Others ............................................................................... 23 
Number of Zero Flow Days............................................... 23 

5.4 Advanced .......................................................................................... 24 
5.4.1 Reporting Period .............................................................. 24 

Whole Record.................................................................... 24 
Every Year......................................................................... 24 
Single Year ....................................................................... 24 

   ii



  Contents 

Every Season .....................................................................24 
Every Month ......................................................................25 

5.4.2 Summary Statistics ............................................................25 
Annual summary...............................................................25 
Seasonal summary............................................................25 
Single Season....................................................................25 
Monthly Summary .............................................................25 
Single Month .....................................................................26 

5.5 Colwell’s Indices ................................................................................26 
5.5.1 Reported Indices ...............................................................27 

Predictability .....................................................................27 
Constancy ..........................................................................27 
Contingency.......................................................................27 

5.5.2 Based on (basis for calculating Colwell’s indices) ............27 
Mean .................................................................................27 
Median ..............................................................................27 
Maximum...........................................................................27 
Minimum ...........................................................................27 

5.5.3 Variables...........................................................................28 
Time Period .......................................................................28 
Monthly .............................................................................28 
Seasonal............................................................................28 

5.5.4 Class Distribution ..............................................................28 
Basis for Calculation .........................................................28 
Number of Flow Classes....................................................30 
Transform Flows ................................................................31 
Logarithmic Class Size ......................................................31 

5.6 Flood Frequency.................................................................................31 
5.6.1 Fitting a log Pearson Type 3 curve ...................................32 
5.6.2 Partial Duration ................................................................32 

Number of Floods..............................................................32 
Magnitude of threshold flood ...........................................32 
ARI Partial Series ..............................................................33 

5.6.3 Annual Series ....................................................................33 
ARI Annual series..............................................................33 

5.6.4 Slope of the flow duration curve.......................................33 
5.7 Low and High Flow Spell Analysis.....................................................34 

5.7.1 Low Flow Spell analysis.....................................................34 
5.7.2 High Flow Spell Analysis ...................................................34 
5.7.3 Reported Values................................................................35 

   iii



River Analysis Package - Users Guide   

Number............................................................................. 35 
Average duration ............................................................. 35 
Single Longest .................................................................. 35 
Total duration................................................................... 35 
Magnitude ........................................................................ 35 
Period Between ................................................................ 35 

5.7.4 Threshold.......................................................................... 35 
5.7.5 Independence Criteria...................................................... 36 

How TSA handles overlapping spells between time 
periods.............................................................................. 36 

5.8 Base Flow Analysis ............................................................................ 36 
5.8.1 Base Flow Method ............................................................ 37 

Base flow index ................................................................ 37 
Flood flow index ............................................................... 37 
Mean daily base flow ....................................................... 37 
Base flow time series plot ................................................ 37 

5.9 Rises and falls ................................................................................... 38 
Mean magnitude .............................................................. 38 
Mean duration.................................................................. 38 
Total duration................................................................... 38 
Mean rate ......................................................................... 38 
Single greatest rate.......................................................... 39 

5.10 Haines Seasonality measure ............................................................ 39 
5.11 Wettest versus driest years ............................................................... 39 
5.12 Output Table ..................................................................................... 40 
5.13 Output Visualisation ......................................................................... 40 

5.13.1 Flow Duration Curves ....................................................... 41 
5.13.2 Flood Frequency ............................................................... 41 

Appendix A - References ........................................ 42 

  

   iv



  Introduction 

1 Introduction 
The River Analysis Package (RAP) is a toolbox of quantitative techniques for Environmental 
Flow management. RAP has several modules to help river managers, scientists and 
consultants to tackle a range of river management projects. RAP is primarily targeted at the 
allocation of environmental flows, however future modules will be useful for other forms of 
river restoration such as predicting channel geometry for re-engineered channels and 
understanding relationships between flow, hydraulics and biota. RAP B.1.0.0 has been 
released with two operational modules. 

1.1 Hydraulic Analysis (HA) 
The Hydraulic Analysis (HA) module has been based on the Flow Events Method (Stewardson 
and Gippel, 2003) of allocating environmental flows. The HA module allows users to 
construct a one dimensional hydraulic model of a river reach and to determine ecologically 
relevant flow thresholds based on hydraulic parameters such as water depth and velocity. HA 
allows the creation of a time series of potentially ecologically relevant hydraulic data for 
subsequent analysis in TSA and comparison with biological data or alternative flow regimes. 

1.2 Time Series Analysis (TSA) 
The Time Series Analysis (TSA) module of the River Analysis Package (RAP) has been 
developed to produce a graphical user interface that allows users to interactively investigate 
time series data. TSA is designed for use as an interpretive tool. TSA input must be daily time 
series data, it is designed for stream flow data but can equally be used for hydraulic time 
series data or meteorological data. The algorithms underlying TSA are used by the Rules 
Based Models (RBM) module and Quantitative Models (QM) module of RAP to predict 
biological responses to alternate flow scenarios.  

1.3 The user guide 
The RAP Users Guide can be printed or viewed as a single PDF document for those users 
who like to read a report from cover to cover. The RAP Users Guide is also the basis for the 
online Help featured in RAP, all the content of this document can be found in the RAP Help 
menu. 
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1.4 River Analysis Package 

1.4.1 Overview 

RAP can be used for many purposes depending on the demands of the user, here are some 
suggestions;  

• Hydrologists,  

Interactively compare pre- and post-regulation flow regimes, or compare flow regimes of 
different streams, to aid in the development of flow allocation strategies. 

• Civil engineers,  

Use a partial duration series to calculate discharge for design floods less than 10yr ARI. 

• Stream managers, 

Assess the likely habitat limitations imposed by hydrologic regime, rapidly produce summary 
reports for other users.  

• Freshwater Ecologists, 

Quantify the flow regime by calculating flow metrics for statistical comparison with temporally 
and spatially variant biological data to provide a clearer understanding of the association 
between hydrology and aquatic habitat. 

• Fluvial Geomorphologists, 

Create a one dimensional hydraulic model of a river reach and calculate a time series of 
geomorphically relevant hydraulic parameters (e.g. threshold of bed sediment transport). 

Hydraulic Analysis (HA) Module 

HA uses a one-dimensional hydraulic model to calculate potentially ecologically relevant 
hydraulic metrics and to visualise the depth of flow at different cross-sections. 

Time Series Analysis (TSA) module 

TSA uses daily time series data (e.g. flow data) to generate summary statistics or plots of 
changes in statistics through time. TSA is used for comparing alternate flow regimes, 
identifying changes in a flow regime through time and for generating flow statistics that can 
be used to predict the likely biological response to flow change. 

1.4.2 Features 

Hydraulic Analysis (HA) 

HA allows the importation of HECRAS (US Army Corp of Engineers- USACE) cross-section 
data, as well as user input cross-section data to create a 1-D hydraulic model of a river 
reach. The FldWav (pronounced “Flood Wave”) (USA National Weather Service) 1-D 
hydraulic model is used to calculate a hydraulic parameters in the reach for multiple 
alternative discharges, the hydraulic parameters are presented as a rating curve for each the 
hydraulic parameters versus discharge. If a time series of discharge is provided this can be 
converted to a time series of hydraulic parameters that can be subsequently analysed in TSA. 
The hydraulic parameters calculated by HA are: 

• Surface width 

• Wetted Perimeter 
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• Cross-sectional area 

• Local depth 

• Thalweg Depth 

• Lateral gradient 

• Volumetric flow per width 

• Bulk (Mean) flow velocity 

• Hydralic Radius 

• Froude Number 

• Aspect ratio 

Time Series Analysis (TSA) 

TSA calculates time series metrics for post processing in other statistical packages as well as 
proving a graphical display of how alternative metrics change through time. 

TSA calculates the following time series metrics: 

• General statistics, Mean, median, Q90, Q10, Skew, coefficient of variation 

• High flow spell analysis 

• Low flow spell analysis 

• Colwell’s statistics 

• Rates of rise and fall 

• Base flow analysis 

• Partial series flood frequency 

• Annual series flood frequency 

• TSA has the following graphical interface features: 

• Display input data 

• Display graphical interpretation of time series metrics (based on annual, seasonal, 
monthly basis) 

• Flow duration curves (whole period, annual, seasonal, monthly) 

• Flood Frequency curves (partial and annual series) 

• Baseflow component of flow 

1.4.3 Audience 

RAP is intended for scientists in the field of environmental flows, hydrology and hydraulics 
field. It is also intended that RAP will be used by government agencies, environmental and 
engineering consultants, water managers and as a communication tool for community 
consultation. RAP is also used in undergraduate engineering and science teaching. 
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1.5 Data requirements 

1.5.1 Input data 

Time Series Analysis (TSA) 

TSA allows simple drag-and-drop of common formats of daily streamflow data; 

• Comma delimited (.csv) with the first column a daily time step date and subsequent 
column(s) as data. 

• IQQM:- standard output format from the Integrated Quality, Quantity Model 
produced by the New South Wales Department of Land and water Conservation. 

Time Series Data 

The basic time unit of TSA is daily, however it is anticipated that sub-daily, monthly, seasonal 
and annual time series data will also be handled by TSA.  

Time series data must be gap free, that is, there must be no empty cells if viewed in a 
spreadsheet. Users should ensure that any gaps in the input data are filled with –9999. For 
the Beta release of RAP, even –9999 values can create difficulty for some calculations, hence 
it is best to only load complete time series data with no missing data or null values (-9999). 

Visualisation 

TSA provides an input screen to allow users to zoom in and out and pan through the time 
series data for a quick visual overview of the data. 

Output from TSA is presented in visual summaries for easy interpretation 

Time period for analysis 

TSA can handle any length of input data from 1 day to 1000 years. Some functions are not 
available for very short records. 

Time period for summary computation 

The analysis of the input time series can, for most metrics, be undertaken for the whole 
period, years, up to six user-defined seasons, and months. 

Measures of central tendency 

TSA provides both mean and median measures of central tendency for any statistic where 
multiple outputs are produced. The measures of central tendency are Mean and median, and 
the measures of variation around these are coefficient of variation (CV) which is the standard 
deviation/mean, and the Variability which is a range defined by percentiles (e.g. Q10-Q90) 
divided by the median. 

Hydraulic Analysis (HA) 

HA uses channel cross-sectional data in order to create a one-dimensional hydraulic model. 
The cross-sectional data can be entered directly into HA, or by copying and pasting cells 
from a spreadsheet application or by importing data hydraulic model already setup in 
HECRAS (US Army Corp Engineers). In order to run the 1-D hydraulic model, Channel 
roughness factors must be assigned for each cross-section. The channel roughness 
(Manning’s n) can be varied according to discharge, or set as a constant value for all 
discharges. 

In order to create an output time series of a hydraulic parameter (e.g. average depth), you 
must load time series flow data and combine it with a rating curve of the hydraulic 
parameter. That is, combine daily discharge with a rating curve of average depth versus 
discharge to create a time series of daily depth. The newly created time series file can be 
saved or exporting to TSA for analysis. 
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1.5.2 Output data 

Hydraulic Analysis (HA) 

The main output from the hydraulic analysis module are time series of hydraulic parameters. 
These can be saved as comma delimited files. 

Time Series Analysis (TSA) 

As well as a visual output, TSA provides tabulated numeric output that can be simple saved 
as a comma delimited filed for input into other post processing statistical packages. 

1.6 Product components 
The River Analysis Package (B1.0.0) contains the Time Series Analysis Module and Hydraulic 
Analysis Module. It is intended that future Versions of RAP will also include a module for the 
prediction of biological response to flow change (Rules Based module and Quantitative 
Models Module) as well as a module to allow the prediction of regional channel morphology 
characteristics. 

1.7 References and training 
RAP is a product developed jointly by the CRC for Catchment Hydrology (CRCCH) and CRC 
for Freshwater Ecology (CRCFE). Each module of RAP has a different development team, as 
such each module should be referenced separately.  

The Hydraulic Analysis module can be referenced as: 

Stewardson M, and Marsh (2004) Hydraulic Analysis Module: River Analysis Package. 
Cooperative Research Centre for Catchment Hydrology, Monash University, Melbourne 
Australia. 

The Time Series Analysis module can be referenced as: 

Marsh N. (2004) Time Series Analysis Module: River Analysis Package, Cooperative 
Research Centre for Catchment Hydrology, Monash University, Melbourne Australia. 

As part of the product delivery, the CRCCH runs training workshops. Details of workshops 
are posted on the Toolkit web site (www.toolkit.net.au) in the news and events sections. 
References for relevant conference papers and journal articles are also available at the 
Toolkit web site, in the RAP member’s area. A discussion forum for RAP users is available in 
the RAP members area, feel free to view recent discussion topics and ask questions of the 
RAP development team and other RAP users. 
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2 Installation 

2.1 Technical specifications 

Minimum Requirements 

Processor  133-megahertz (MHz) Intel Pentium-class processor  

Operating 
System 

RAP is supported on the following platforms: 
Microsoft Windows® Server 2003* (.NET Framework 1.1 is installed as part of the 
operating system)  
Windows XP Professional*  
Windows XP Home Edition  
Windows 2000*  
Windows Millennium Edition (Windows Me)  
Windows 98  
Microsoft Windows NT® 4.0 Service Pack 6a  
 
RAP cannot be installed on 64-bit computers  

Memory 128 megabytes (MB) of RAM, 256 MB recommended  

Hard Disk 10 MB of hard disk space required 

Display 1024 x 768 or higher-resolution display with 256 colours  

Input Device Microsoft mouse or compatible pointing device  

Other Microsoft Internet Explorer 5.01 or later is required.  
The .net framework 1.1 redistributable or later is required. 

Table 1 System requirements 

The person installing the software must have local administrator access on the computer. 
Ideally, you should also have the relevant permissions to install and uninstall software. 

Note If you are using a networked computer, then inform your system 
administrator BEFORE applying any service packs or updates, as there 
may be other applications on your computer that could be affected by 
these updates. 
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2.2 Distribution media 
RAP is distributed via the Toolkit web site and can be downloaded by: 

1  Going to the Toolkit web site (www.toolkit.net.au) 

2  Registering as a toolkit user 

3  Once a registered toolkit user, then going to the users download area and selecting 
RAP. 

4 Press the Submit button to commence the download 

2.3 Licence agreement 
Acceptance of the licence agreement is part of the installation procedure. You must 
acknowledge that you have read, understood and agree to be bound by RAP software 
licence agreement to be able to proceed with the installation. The licence agreement can be 
viewed when using RAP by selecting Help  > About and selecting the Licence agreement 
button. 

2.4 Folders 
The RAP installer creates a data directory that contains: 

1 The RAP software (default path c:\Program Files\Toolkit\RAP) 

2 Documentation (this User Guide, default path c:\Program 
Files\Toolkit\RAP\documentation) 

3 Sample data (default path c:\Program Files\Toolkit\RAP\Sampledata) 

2.5 Installation 

2.5.1 Framework Installation 

The .NET Framework is a component of the Microsoft Windows® operating system used to 
build and run Windows-based applications. RAP is built using the .NET Framework and 
consequently requires that the .NET Framework redistributable be installed prior to running. 
The .NET Framework Redistributable will install the .NET Framework onto your machine and 
is downloadable from www.msdn.microsoft.com/netframework/downloads/redist.aspx. 

You can check to see if you already have the .NET Framework installed by clicking Start on 
your Windows desktop, selecting Settings > Control Panel, and then double-clicking the Add 
or Remove Programs icon. When that window appears, scroll through the list of applications. 
If you see Microsoft .NET Framework 1.1 listed, the latest version is already installed and you 
do not need to install it again. 

2.5.2 Stand-alone PC 

After downloading the software to a local directory, double clicking RAPsetup.exe will initiate 
an install wizard which leads you through the install procedure. Once again, you must 
indicate that you have read, understood and agree to be bound by RAP licence agreement. 
There are two decisions to be made during the installation, the name of the install directory 
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(default is C:\Program Files\toolkit\RAP), and if the user wishes to also load sample data 
(default is yes) 

Potential Problems If your computer doesn’t have enough space to install the data, the 
install procedure will give you an out of disk space message. Select 
Cancel to exit the installation procedure. You will need to find a larger 
disk drive. 
 
If the .NET framework is not installed on your machine, the install 
procedure will give you a warning message. Select cancel the 
installation procedure. You will need to install the .NET redistributable 
software . 

2.6 User Interface 
RAP uses standard Microsoft Windows® windows. The features in the window are the: 

• Title bar that includes the Toolkit icon followed by the product name and a version 
number. 

• The standard windows minimise, maximise/restore and close icons. 

Optional top level menu. 

 

  Figure 2-1: Example of RAP window  

To minimise or maximise a window or restore it to its previous size 

Click the appropriate button in the upper-right corner of the window:  

• Click to minimise the window to a taskbar button. To restore the minimised 
window to its previous size, click its taskbar button.  

• Click to maximise the window so it covers the full screen.  

• After maximising a window, click to restore the window to its previous size.  

Note You can also double-click the window's title bar to maximize it or 
restore it to its previous size.  
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You can click on the Toolkit icon on the left of the title bar or right click on the title bar to 
display a menu to restore, move, size, minimise, maximise or close the window.  

The title line contains the name of the software followed by a version number. The version 
number is in three parts; x.y.z where: 

x Major Version indicator (integer starting at 1) 

y Minor Version indicator (integer starting at 0; may go to any number but rest on a 
major version change) 

z Bug fix indicator (integer starting at 0; may go to any number but reset to zero on a 
minor or major version change. 

The suffix b may be added to a version number to denote that the software is a beta release. 

2.6.1 Start Menu icons 

The start menu icon is the standard Toolkit triple-drop icon with the acronym RAP 
underneath. 

2.6.2 Screens or dialogs 

When a module of RAP is selected, the module screen appears, with a tree view to the left of 
screen and a context sensitive menu at the top of the screen for navigation. Users can make 
selections of RAP options via the right side of the screen. These user options can be saved or 
loaded via the file menu. 

2.6.3 Mouse & keyboard controls 

You can navigate around RAP pages using the TAB button, or the mouse. 

2.6.4 Manual configuration 

Advanced user options are available for the Time Series analysis module. Advanced user 
options allows the units (e.g. m3/s, Ml/d) to be set, the analysis period and the method of 
analysis. 

2.7 Uninstalling RAP 
To uninstall RAP go to Start > Control Panel > Add Remove Programs. Select RAP, select 
uninstall. RAP will be removed from your system. 
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3 Using RAP 

3.1 Getting started 
To run the River Analysis Package click on the RAP icon on the desktop or select Start  > 
Programs  > Toolkit  > River Analysis Package. 

The RAP introduction splash screen will appear will appear for approximately 5 seconds or 
until a mouse button or key is pressed. The RAP menu will then appear. In the centre of the 
screen are a selection of the available modules within RAP. If the mouse is moved over a 
module button, a brief description on the module appears to the right. Select a module by 
single clicking on the appropriate button. 

Each module of RAP has a menu across the top of the largest window. This menu is context 
sensitive in that it changes depending on which module you currently have active. You can 
have both TSA and HA modules open at the same time, however whichever window ‘has 
focus’ will determine the menu on the largest window. The window with the bold banner has 
focus.  

As well as the context sensitive menu at the top of the main window, each RAP module has a 
tree-view to the left side of the screen to help navigate around the software. The tree-view is 
a replication of the menu, however you can have several nodes of the tree open at once for 
easy navigation (Figure 3) where as the menu automatically hides the lower-level items once 
it has lost focus. 
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 Figure 3-2: Tree view for easy navigation  

3.2 How to Run HA (quickstart). 
For a quick introduction to running the Hydraulic Analysis module, follow these steps (more 
information in subsequent sections); 

1 Open RAP 

2 Select Hydraulic Analysis 

3 Select Input > Section data on the left tree view 

4 To load a river network, go to File > Open > Survey Data, then navigate to some 
sample data (try c:\program files\toolkit\RAP\Sample data) open the .go1 file by 
double clicking with the mouse (left button).  

5 Got to Hydraulic Model >  Hydraulic Model run on the tree view, Hit the “Run 
FldWav” button to run the hydraulic model. 

6 Explore the output by looking at the Output > Water Levels, Output > Rule Library, 
or Output > Rating Curves screens. 

7 You can convert the hydraulic data to a time series of hydraulic data, go to the 
Output  > Export screen. Drag a time series file to the “Input Discharge Time Series” 
box (try c:\program files\toolkit\RAP\Sample data). Select a hydraulic parameter, and 
either save the time series or send it to the Time Series Analysis package. 
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3.3 How to run TSA (quickstart) 
For a quick introduction to analysing some time series data, follow these steps (more 
information in subsequent sections); 

1 Open RAP 

2 Select TSA 

3 Select Input > Import data on the left tree view 

4 Open windows explorer and navigate to some sample data (try c:\program 
files\toolkit\RAP\Sample data) grab the .csv file by selecting with the mouse (left 
button).  

5 Drag and drop the file onto the plot area of the input scree. That is keep the left 
mouse button depressed while dragging the file to the plot area of the input screen in 
TSA, release the mouse button. 

6 Select Project Options > General statistics in the tree view 

7 Click some boxes to select statistics to calculate. 

8 Click the run button (below the tree view) 

9 The output data table should be displayed 

10 Graphical output can be viewed by navigating via the output tree view node. 
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4 Hydraulic Analysis 
Module 
The Hydraulic Analysis Module is started by selecting the button at the start up screen or 
going to File > New > Hydraulic Analysis. There is not restriction on the number of 
Hydraulic Analysis sessions open at any one time. 

4.1 Input Section Data 
To construct a hydraulic model, you first need to enter channel survey data. Survey data 
consists of cross-sectional stream surveys, all recorded against the same horizontal datum. 
You can import section data that has been saved from HECRAS, or enter it directly into HA. 
To load a file from HECRAS, go to File > Import > Survey data and select the HECRAS .go 
file. 

 

   Figure 4-3:  Input section data screen   

To enter data manually, first enter the river (select the Add River button) and name it 
accordingly. Select the river which you have just added and click the radio button to state 

   13



River Analysis Package - Users Guide   

whether Manning’s n values should be based on discharge or river height (default is 
Discharge). You can also specify the number of water surface elevations used as input to the 
hydraulic model. 

Select the Add Cross-section button to add a cross-section. Enter the longitudinal distance 
(Downstream Location) for the cross-section (this is usually the number of metres upstream 
from the mouth or confluence). To add cross-section survey data, select a row in the Location 
of Points table, select Edit Row, and enter the distance across the channel (Run) and the 
height for each point. Continue to do this for all points in the cross-section by selecting the 
Add Row button for each new set of cross-section points. Alternatively if your data is in a 
spreadsheet, simply copy it from the spreadsheet, click the Location of Points table and select 
the Past Table button. 

As you enter cross-section points you will notice the cross-section appearing in the top right 
hand side of the screen, this helps you avoid data entry errors. As you step through the points 
in the table, a red circle will follow your position in the plot of the cross-section to help 
navigate your position in the cross-section. 

To construct a hydraulic model you also need to enter the channel roughness for each cross-
section. Select the Manning’s n values button near the bottom of the display to switch to a 
table of Manning’s n values. Manning’s n can be specified as constant for all discharges, or 
can be varied according to discharge. At least one Manning’s n value must be specified for 
each cross-section, the default setting is 0.04.  

4.2 Hydraulic model 

 

  Figure 4-4:  Hydraulic model Run Screen   

Once all the channel cross-section data has been entered, you can run the hydraulic model 
by entering the minimum and maximum flow range (m3/s) that you would like to consider, 
then selecting the Run FLDWAV button. Alternatively, if you have a hydraulic model that you 
have previously built and run in HECRAS you can import the HECRAS Summary Table (.csv 
format) by selecting Import HECRAS Profile Summary Table. 
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4.3 Water Levels 

 

  Figure 4-5:  Water Levels screen  

Once the hydraulic model has been run, or data imported from a hydraulic model 
elsewhere, you can investigate the water level at each cross-section for varying discharges. 
Select cross-sections from the available list then use the slider bars for the two alternative 
discharges to observe the water level change. The bottom plot shows the longitudinal water 
surface profiles for the modelled reach. By hovering the mouse over any of the plots the 
water surface elevations for the two discharges will appear near the mouse pointer. This is 
particularly useful if you are trying to determine at what discharges benches become 
inundated, or at what point the channel bed is likely to be out of the photic zone in turbid 
rivers with limited light penetration. 
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4.4 Rule Library 

 

  Figure 4-6:  Rule Library screen  

A key feature of the Hydraulic analysis package is the ability to investigate the effect of 
different combinations of hydraulic parameters. The Rule library allows you to use predefined 
hydraulic parameters and to create your own by combining hydraulic parameters.  

Firstly select a rule (New Rule, for the first one), then name it, say “photic zone” for example. 
Select the first predicate, for example we may be interested in water depth less then 1m, 
select the Local Depth, then select < in the drop down box then enter 1 in the right box.  

 

  Figure 4-7:  Select the local depth in the predicate box  

Suppose we are also interested in channel benches. Click + to add a predicate, select 
Lateral Gradient, Select < and type 0.1 (i.e lateral slope less than 1 in 10). Now we can 
combine these two predicates as a rule. In the rule box, say IF 1 and 2 then Select>> and 
enter 1. Hit the Commit button. You now have a photic zone rule. For a turbid river where 
benthic metabolisms is important and light penetration is limited, and horizontal surfaces are 
important for colonisation, you now have a rule that tells you the proportion of bench area 
with less than 1m water depth, i.e. the area available for benthic metabolism under a range 
of discharges. To take full advantage of the implications of this rule, go to the Rating Curves 
Screen. 
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4.5 Rating Curves 

 

  Figure 4-8:  Rating Curves screen   

Each of the pre-defined rules as well as any that you create can be viewed for each of the 
cross-sections that you have loaded. The rating curve shows the change in the rule or 
hydraulic parameter with discharge for each cross-section. If you are interested in a reach 
summary rating curve, select the cross-sections that represent your question (you may be 
interested in pools, riffles or the average of all cross-sections. Select the cross-section 
parameter, and the method of combining (minimum, maximum or average), and press 
Commit to see the final summary rating curve. You now have a summary measure of how 
your particular rule or hydraulic parameter varies with discharge across a range of cross-
sections. This spatial summary is a great way to review the effect of discharge variation on 
the selected hydraulic parameter. However it is often very useful to investigate how this 
parameter changes through time by combining the rating curve with flow data.  
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4.6 Time Series Export 

 

   Figure 4-9:  Time Series Export screen   

Drag a flow time series on to the top plot (data in m3/s). Select a reach parameter that you 
have created a rating curve for, and review the time series of the reach parameter in the 
bottom plot. To further explore the time series of hydraulic parameter, pass the data to the 
Time Series Analysis module for exploring trends such as seasonal variation, distribution or 
skew and for comparing hydraulic parameters for alternate flow regimes. 
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5 Time Series 
Analysis 
The Time Series Analysis module is started by selecting the button at the start up screen or 
going to File > New > Time Series Analysis. There is not restriction on the number of Time 
Series Analysis sessions open at any one time. 

5.1 Input 

 

  Figure 5-10:  Time Series Input Screen  

Time series data may be entered by dragging and dropping on to the view control (plot) on 
the bottom of the panel, or by selecting a file by clicking the Add files… button. To load time 
series they must be gap free and be free of null entries (i.e. -9999). TSA handles most 
common formats of input data. If there is a problem loading a particular data file, make the 
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input data two columns, one with date (based on the date setting on your computer, 
dd/mm/yyyy in Australia) the second with the flow data (exclude column headings, and make 
sure the file is saved as a comma delimited .csv file).  

Loaded time series are listed in the list box to the top right. You can select and deselect the 
time series by clicking on the tick in the box. If you Right Click on the view control you can 
select to zoom in, pan or change the settings like colour as well as save the output from the 
plot. 

Only time series that are loaded and selected on the time series are analysed in subsequent 
analysis. Only the concurrent period between multiple open input time series can be 
analysed, therefore input time series must have a concurrent period to allow analysis. 

5.2 Reporting Period 

 

 Figure 5-11:Reporting Period Screen 

The period of analysis for RAP TSA does not need to be the entire period of the input record, 
you can specify a shorter period, however RAP TSA will not allow you to specify a reporting 
period outside the concurrent period of input time series. The water year operates from the 
start of the input period, however for future versions of RAP TSA you will be able to specify a 
water year start or ask RAP TSA to calculate it for you, where the water year start is the first 
day of the month of lowest mean daily flow for the input record. 

RAP TSA can analyse time series data for the whole period, years, seasons and months. You 
can specify the seasons to report, there must be a minimum of two seasons and if more than 
two they must be in order of occurrence. An example may be to specify a wet season and dry 
season or maybe a spawning season, growing season and stress season. 

5.3 General Summary statistics 
TSA provides a range of summary statistics for quantifying commonly requested flow metrics. 
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  Figure 5-12:  General Summary Statistics Screen  

5.3.1 Summary 

Minimum Daily Flow 

The minimum flow is the smallest input value for the specific reporting period. See the 
advanced options for varying the reporting period.  

Maximum flow 

The maximum flow is the largest input value for the specific reporting period. See the 
advanced options for varying the reporting period. 

Q10 

The Q10 is the flow exceeded 10% of the time, that is, it is the discharge that indicates the 
top 10% of the flow for the reporting period. See the advanced options for varying the 
reporting period. 

Q90 

The Q90 is the flow exceeded 90% of the time, that is, it is the discharge that indicates the 
lower 10% of the flow for the reporting period. See the advanced options for varying the 
reporting period. 

Mean daily Flow 

The mean flow is a measure of central tendency. It is calculated as the average of all flow 
records considered over the analysis period (sum of flow values/number of days). See the 
advanced options for varying the reporting period. 
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Median Daily Flow 

The Median Flow is a measure of central tendency. The Median Flow is the "middle" flow for 
the entire record. That is the median is the flow exceeded 50% of the time. The median is 
usually much lower than the mean daily flow because the distribution of discharge data is 
negatively skewed with a lower limit of zero and no upper limit. See the advanced options for 
varying the reporting period. 

5.3.2 Distribution 

Coefficient of Variation of Daily Flow 

The coefficient of variation is the division of a mean by the standard deviation value. The CV 
of daily flow is the standard deviation for the daily flow values divided by the mean of all 
daily flow values. See the advanced options for varying the reporting period. 

Standard Deviation of Daily Flow 

The standard deviation is a measure of how widely the values are dispersed from the mean 
value. The Standard Deviation has the same units as the input data. See the advanced 
options for varying the reporting period. 

 

where  

n = number of values 

x = value 

Skewness of Daily Flow 

Skewness is a measure of how different the mean and median flows are. Skew = 
mean/median flow. For a small catchment stream the base flow will normally be very low, 
with a dramatic change in discharge during a storm event. Most of the discharge thus occurs 
during a storm, however most of the days are low flow. Hence the median flow is low, and 
the mean flow is elevated by the much larger event-based discharges. As a consequence the 
Skewness of a small catchment would be greater than that of a large catchment. Similarly, 
the Skewness of an unregulated stream will tend to be greater than that of a regulated stream 
(depending on the flow release strategy). See the advanced options for varying the reporting 
period. 

Variability of Daily Flow 

The measure of variability used by TSA is based on the use of the median flow as a measure 
of central tendency. Variability is calculated as the range divided by the median. The range is 
defined by the user in terms of the percentile range of flows. The default setting for the range 
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is the difference between the Q10 and Q90 flows. Where the whole record is used, this 
measure of flow variability is used to describe the entire record. See the advanced options for 
varying the reporting period. 

Range of Daily Flows 

The range of daily flows is based on a user defined range of percentile values. The range is 
used to compute the Variability of Daily Flow. The default range is Q10-Q90, that is the flow 
exceeded 10% of the time minus the flow exceeded 90% of the time. The range is used in 
conjunction with the median flow to describe the variability of Daily Flow of flow using a 
median rather than mean based measure of central tendency.  

The range is user defined by selecting the appropriate range value (on the right of the 
summary statistics page): 

Q10-Q90 

Q15-Q85 

Q20-Q80 

Q30-Q70 

Standard deviation of the log of daily flows (S_Log) 

The S_Log, is an estimate of the standard deviation of the logarithm (base 10) of the daily 
flow values. Flow data is often logged to reduce the skew, S_Log is a measure of the 
distribution of this transformed data, as such it provides a description of the skew of the input 
data (reference (Gordon et al., 1992), pp376).  

 

where: Q= discharge 

Lanes variability index (Lanes) 

The Lanes variability index is described as the standard deviation of the logarithms of the Q5, 
Q15, Q25, ….,Q85 and Q95 values. Lanes variability index is unsuitable for data sets with 
more than 5% zero values (i.e. Q95 = 0) or data sets dominated by zero flows.(Gordon et 
al., 1992).  

5.3.3 Others 

Number of Zero Flow Days 

The number of zero flow days for the entire record under analysis are counted. The number 
of zero flow days does not include days with a missing record unless they are filled with zero 
values. See the advanced options for varying the reporting period. 
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5.4 Advanced 
Advanced provides alternative reporting techniques, such as a single summary value for the 
entire record, annual, seasonal or monthly values. The advanced reporting options applies to 
general statistics, high flow spell analysis, low flow spell analysis, rates of rise and fall and 
base flow. 

 

 Figure 5-13:  Advanced reporting options  

5.4.1 Reporting Period 

Whole Record 

If Whole record is selected, the output is a single value for the whole period. If you have 
selected Minimum daily flow and Whole period, the output will be a single value for the 
minimum daily flow for the whole period.  

Every Year 

If Every Year is selected the output table will list statistics for every year of the record. For 
example if a 20 year record is entered, minimum daily flow is selected from General 
statistics, and Every Year is selected then the output grid will display a minimum daily flow for 
each of 20 years. 

Single Year 

If Single Year is selected (and a year selected in the scroll list box), the output grid will display 
data for a single year.  

Every Season 

If Every Season is selected, the output grid will display statistics for every season in the record. 
For example if a 20 year record is entered, and 4 seasons have been entered, and minimum 
daily flow is selected from General statistics, and Every Season is selected then the output 
grid will display a minimum daily flow for each of 4 seasons for each of 20 years (100 output 
values). 
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Users can alter the number and duration of seasons by selecting Input > Reporting Period. 
Up to 6 seasons can be entered, they must be entered in the order in which they occur 
(although you can start with any season). You can name the seasons anything you like. The 
minimum number of seasons is 2. 

Every Month 

If Every Month is selected, the output grid will display statistics for every Month in the record. 
For example if a 20 year record is entered and minimum daily flow is selected from General 
statistics, and Every Month is selected then the output grid will display a minimum daily flow 
for each of 12 months for each of 20 years (240 output values). 

5.4.2 Summary Statistics 

As well as reporting statistics for each year, season or month, you can also calculate 
summary statistics to represent these values. Two measures of central tendency are available, 
Mean and Median, and two associated measures of variability are also available, Coefficient 
of Variation (mean/Standard Deviation) and Variability (Median / (10th-90th percentile)). Be 
aware that CV will only provide a sensible value if the standard deviation is a real value (i.e. 
there must be more than 1 datum point to calculate a standard deviation). Also be aware 
that the variability measure will give a zero value for data sets with a zero median, and 
infinity value for zero ranges. 

Annual summary 

The mean, Median CV or variability can be determined from the record of annual values. For 
example, if a 20 year record is selected, the minimum daily flow is selected from the general 
statistics and annual and mean, median, CV and variability are selected in the reporting 
period (as well as annual), the output grid will have 4 values, the mean of annual minima, 
the median of annual minima, the CV of annual minima and the variability of annual 
minima.  

Seasonal summary 

The mean, Median CV or variability can be determined from the record of seasonal values. 
For example, if 4 seasons are selected for a 20 year record, the minimum daily flow is 
selected from the general statistics and annual and mean, median, CV and variability are 
selected in the reporting period (as well as seasonal), the output grid will have 16 values, the 
mean of seasonal minima, the median of seasonal minima, the CV of seasonal minima and 
the variability of seasonal minima for each of 4 seasons. 

Single Season 

The mean, Median CV or variability can be determined for a single season from the record 
of seasonal values. For example, if 4 seasons are selected for a 20 year record, the single 
season of “Summer” is selected as the single season, the minimum daily flow is selected from 
the general statistics and annual and mean, median, CV and variability are selected in the 
reporting period (as well as seasonal), the output grid will have 4 values, the mean of 
Summer minima, the median of Summer minima, the CV of Summer minima and the 
variability of summer minima. 

Monthly Summary 

The mean, Median CV or variability can be determined from the record of monthly values. 
For example, if a 20 year record is selected, the minimum daily flow is selected from the 
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general statistics and annual and mean, median, CV and variability are selected in the 
reporting period (as well as monthly), the output grid will have 240 values, the mean of 
monthly minima, the median of monthly minima, the CV of monthly minima and the 
variability of monthly minima for each of 12 months. 

Single Month 

The mean, Median CV or variability can be determined for a single month from the record of 
monthly values. For example, if a 20 year record is selected, the single month of “January” is 
selected as the single month, the minimum daily flow is selected from the general statistics 
and annual and mean, median, CV and variability are selected in the reporting period (as 
well as monthly), the output grid will have 4 values, the mean of January minima, the median 
of January minima, the CV of January minima and the variability of January minima. 

5.5 Colwell’s Indices 
Colwell’s indices are a measure of the seasonal predictability of environmental events. The 
method was developed for categorical data such as when a tree is fruiting or a fish 
spawning. The seasons in which this occurred or did not occur are recorded and a table of 
presence absence of different events can be constructed. The equations developed by 
Colwell (1974) can then be used to predict: 1) the predictability; a measure of how tightly an 
event is linked to a season, 2) Constancy; a measure of how uniform the event occurs 
through all seasons, and 3) Contingency; a measure of the repeatability of season patterns. 

For detailed information on the calculation and description of Colwell’s indices refer to 
(Colwell, 1974). 

 

  Figure 5-14:  Colwell's Indices  

Colwell’s Indices are based on a tabular representation of the input data. Continuous time 
series data must be converted to categorical data. To convert from continuous data to 
categorical data, flow classes must be selected; the frequency of occurrence of flow in each 
class is recorded. The season in which the flow occurs is also recorded. 
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5.5.1 Reported Indices 

 Predictability 

Predictability is the sum of Constancy and Contingency. Predictability is a likelihood of being 
able to predict a flow occurrence. Predictability is maximized when the flow is constant 
throughout the year (Constancy Maximised), or if the pattern of high or low flow occurrence 
is repeated across all years (Contingency maximized).  

Constancy 

Constancy is maximized when the flow is the same for all seasons, for example a desert river 
with many zero flows will have a high constancy value. 

Contingency 

Contingency is maximized when the pattern of flow is the same from year to year, for 
example, high flows occur every winter of the record. 

5.5.2 Based on (basis for calculating Colwell’s 
indices) 

Mean  

Colwell’s indices are based on the mean value for each time period. If the time period is 
monthly, then the mean daily value of each month is used to construct the Colwell’s data 
table from which the indices are calculated. 

Median 

Colwell’s indices are based on the median value for each time period. If the time period is 
monthly, then the median daily value of each month is used to construct the Colwell’s data 
table from which the indices are calculated.  

Maximum 

Colwell’s indices are based on the maximum value for each time period. If the time period is 
monthly, then the maximum daily value of each month is used to construct the Colwell’s data 
table from which the indices are calculated. 

Minimum 

Colwell’s indices are based on the minimum value for each time period. If the time period is 
monthly, then the minimum daily value of each month is used to construct the Colwell’s data 
table from which the indices are calculated. 
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5.5.3 Variables 

Time Period 

Traditionally, Colwell’s indices have been considered by dividing the flow record on a month 
by month basis. TSA allows the user to interact with these 'seasonal' classifications by 
manually choosing up to six seasons rather than 12 calendar months. 

Only entire years of record are considered such that there are an equal number of each of 
12 months or each of 2-6 seasons.  

Monthly 

You can calculate Colwell’s indices based on monthly flow records. Each calendar month of 
the record is considered as a single flow record, with either the mean, median, maximum or 
minimum daily flow for that month compared to all other months to develop Colwell’s 
indices. You can select either the first whole month of the specified analysis period or select a 
starting month and year. 

Seasonal 

Instead of analysing flow on monthly basis it may be more relevant to consider flow on a 
seasonal basis. For example one may wish to determine the geographic location to delineate 
flow dominated by tropical wet season / dry season conditions from an area of more uniform 
flow. For this analysis the use of just two seasons is more relevant than 12 separate seasons 
(i.e. months) per year. When one considers all 12 seasons (months) a summer dominated 
stream flow may have the same predictability as a winter dominated stream flow, however 
from a water management perspective these may well mean very different things, hence one 
can define the particular period of interest. Seasons are defined in the Input > Reporting 
Period section. 

5.5.4 Class Distribution 

Basis for Calculation 

When considering flow allocation, it may be important to gain an appreciation of the 
predictability of the mean monthly or seasonal flow conditions. However, from a biological 
perspective it may be the extremes of the hydrograph that stimulate activity such as spawning, 
hence one may wish to know the predictability of low or high flow. TSA allows Colwell’s 
indices to be calculated based on the mean daily flow for a season (or month) which is the 
sum of all flows for that season divided by the number of days; the maximum daily flow for 
the season (or month), or the minimum daily flow for that season (or month). 

The basic configuration for calculating Colwell’s indices is to create table recording the 
frequency of occurrence of a range of flow classes for a number of “seasons” then conduct 
the numeric summary of the table as described by the equations below.  
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Figure 5-15:  Example Colwell's input table 

Flow class Summer Autumn Winter Spring 
<100 1 2 3 2 
100-199 2 2 3 2 
200-299 2 2 4 3 
300-399 2 4 4 3 
400-499 3 4 3 4 
500-599 4 3 2 3 
600-699 5 3 2 3 
>699 3 2 1 2 
total 22 22 22 22 
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Where: 

t=number of seasons 

s = number of classes 

Nij = number of cycles for which the phenomenon was in state i at time j. 

Xi = column totals 

Yi = row totals 

Z = grand total 

Number of Flow Classes 

Flow data is a continuous record of different flow magnitudes from low to high flow, rather 
than categorical groups of different flow magnitude. In order to calculate Colwell’s indices 
one must convert the continuous record of flow magnitude into categorical groups of flows. 
How the flow is divided into groups and how many groups are defined will depend on the 
purpose of the analysis. The number of flow classes does affect the calculated Colwell’s 
indices because it changes the distribution of data in summary table from which Colwell’s 
indices are calculated. TSA manages the selection of flow categories by allowing the user to 
have full control of how the flow classes are determined. The user can select the number of 
groups, the threshold daily flow for the lowest group and for the highest group. The division 
of flow in between these two groups into classes can be such that each flow group is of 
uniform size or each is some exponent of the previous.   
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Transform Flows 

Transforming flows by taking the log(x+1) of the flows, effectively reduces the skew of the 
distribution, so that the data approaches normal distribution. The upper and lower bounds of 
the normalized data set are then found and flow classes are divided between these upper 
and lower limits according to the number of classes selected. Ideally, this approach provides 
a good distribution of data cross flow classes, resulting in a reasonable population across all 
flow classes. This distribution is very sensitive to the number of classes selected. If a low 
number of classes is selected (less than 5), then the skew (even the normalized data will still 
be slightly skewed) may result in most of the flow falling in a single flow class. This result will 
give a high Colwell’s constancy across seasons. We would recommend >7 classes (from 
experience, around 11 classes gives consistent results in Contingency and Constancy that 
one would expect from the hydrographs). 

Logarithmic Class Size 

The paper by (Colwell, 1974), suggests that for time series data such as flow or rainfall, the 
divisions between classes could be defined by a logarithmic progression (e.g. base 2) and 
these flow classes applied to the raw time series data. For base-2 class distribution, the class 
sizes are effectively skewed in a similar way to the input data. The class boundaries are set 
with a central class of 20x mean daily flow(MDF), with classes spread either side of this 
central class depending on the number selected by the user. For example if the user selects 5 
classes and base 2 then class boundaries would be; 

1 2-2MDF 

2 2-1MDF 

3 20MDF 

4 21MDF 

5 22MDF 

From experience, base 2 and 11 flow classes seems to give sensible Constancy and 
Contingency values across all basins in Australia. 

5.6 Flood Frequency 
Plots of the flood frequency curve are not featured in RAP V1.0.0 

Flood Frequency has often been used in the design of Engineering structures such as culverts, 
bridges and dams. Flood Frequency analysis is used to provide a predictive capacity to the 
stochastic nature of stream flow. We use the existing, preferably long-term stream flow data 
to predict the likely magnitude of events of a given return period. 

The Flood Frequency analysis uses only complete years of the record. The data used to 
determine the flood frequency commences at the start of the user-defined period and ends 
on the date that describes the maximum number of entire years of record. For example if 
15.5 years of record have been entered then the flood frequency will be calculated based on 
the first 15 years of the record and the final 6 months will be discarded. 

For long return period flows (i.e. greater than 10 years) the annual series is suitable, however 
for predicting floods with return periods of less than 10 years the partial series is more 
suitable (Institution of Engineers Australia, 1987) . The Annual Series flood frequency is 
based on the maximum discharge for each year of the record. The Partial Duration flood 
frequency is based on a collection of the largest discharges for the entire record, i.e. some 
years can have several floods and other dry years have non. 

Flood Frequency is calculated by ranking the selected floods in order of magnitude then 
applying a log-pearson type 3 curve to the data to predict ARI values from those given 
(Institution of Engineers Australia, 1987). In this way the Flood Frequency analysis builds a 
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predictive model based on existing data, as with all such empirical models the accuracy is 
greatly enhanced with a large data set. A general rule for flood frequency analysis is that the 
longer the flow record then the more accurate the predicted ARI. 

 

  Figure 5-16:  Flood Frequency input screen  

5.6.1 Fitting a log Pearson Type 3 curve 

Once the peak flows have been determined, the occurrence of outlier (upper or lower) in the 
flood series is considered and these outliers are discarded (See Australian rainfall and 
Runnoff for the Procedure). A log Pearson Type 3 curve is fitted to the remaining flood series. 
ARI floods are predicted based on linear interpolation between predicted floods on the LP3 
distribution. 

5.6.2 Partial Duration 

The method employed to determine the partial duration series is explained in detail in 
Australian Rainfall and Runoff (Institution of Engineers Australia, 1987) The partial duration 
flood frequency analysis is conducted by considering the peak flows whereby there is an 
average of 1 event per year. The floods have to be considered to be independent floods, 
hence a criteria for determining independence must be established. TSA allows you to specify 
the independence criteria as the minimum number of days between flood peaks or the flow 
must drop below some proportion of the previous flood peak before a new flood can occur. 

Number of Floods 

According to the method employed, the number of floods is equal to the number of years of 
the record. This considers only independent floods according to the user-defined 
independence criteria. 

Magnitude of threshold flood 

The threshold flood is determined by iteratively sorting the flow record to establish a number 
of independent floods equal to the number of years of the record. 
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ARI Partial Series 

Annual Return Interval (ARI) returns the flood magnitude with a return period as specified. A 
one year ARI flood will on average occur every year, a 2 year ARI every 2 years an so on. 

You can specify an ARI to calculate. For ARI's less than 10 years the partial duration series is 
likely to be more accurate than the annual series. The length of record should generally be 
much larger than the ARI intending to be calculated to avoid errors in the extrapolation of the 
data. 

5.6.3 Annual Series 

The annual series flood frequency is calculated using the largest flood in any given year of 
the record. No measure of independence of flood events is considered. Because there is no 
flood independence criteria, the start of the record would usually be the start of the water 
year, however TSA does not calculate this and relies on the user commencing the analysis 
period during low months of record. 

ARI Annual series 

Annual Return Interval (ARI) returns the flood magnitude with a return period as specified. A 
one year ARI flood will on average occur every year, a 2 year ARI every 2 years an so on. 
You can define an ARI for TSA to calculate. The length of record should generally be much 
larger than the ARI intending to be calculated to avoid errors in the extrapolation of the data. 

5.6.4 Slope of the flow duration curve 

Slope of the flow duration curve is not featured in RAPV1.0.0 

A flow duration curve is different from a flood frequency curve because it considers all flows 
and not just the flood flow. The process of constructing a flood frequency curve is to sort all 
the flow data into ascending or descending order then plotting the flow magnitude (log scale 
on y axis) against the probability of flow excedence (normal scale on x axis). The flow 
duration curve is usually shaped like a backward S with low probability of high flows, a 
central reasonably linear section of the curve and a flattening off with high probability of low 
flow. The central section of the plot is usually linear, and the slope (as well as linearity) of this 
section tells us something about the flow regime. Consider an intermittent ephemeral stream, 
there is a very high probability of low or zero flow, and a low probability of very large 
intermittent flow. The middle section of the curve is very steep because the proportion of time 
subjected to medium to high flows is low. Consider a perennial stream with a very large 
catchment; the range of flows can vary dramatically and the large catchment means that 
floods are often extended over a long time period, hence the central linear section of the 
curve would be much flatter.   

The flow duration curve is often used by hydrologists to get a feel for the hydrological 
characteristics of a stream, however their interpretation is not always easy to objectively use 
as a numerical measure of a streams hydrology. The slope of the middle section of the flow 
duration curve (Q10-Q90) has been included in TSA as a means of quantifying the 
difference in one of the key characteristics of the flow duration curve. The R2 value of a line 
fitted to this section of the curve is also provided by TSA to aid the user in assessing the 
linearity of this section of the curve. It is hoped that in future versions of TSA a full graphics 
component may be added to allow the flood frequency and flow duration curves to be 
displayed and printed. 
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5.7 Low and High Flow Spell Analysis 

 

 Figure 5-17:  High Flow Spell analysis Input screen  

Spell analysis is a common way to consider the extremes of the Hydrograph. Low Flow Spell 
Analysis calculates statistics based on when the stream flow drops to or below a predefined 
threshold level. Similarly High Flow Spell Analysis calculates statistics based on when flow 
equals or exceeds a predefined upper limit. 

5.7.1 Low Flow Spell analysis 

The key to successfully using spell analysis is to select meaningful thresholds. TSA allows you 
to input a discharge that has been determined to be important for the particular analysis. For 
example, for a low flow Spell Analysis one may be interested in how frequently the depth of 
flow over riffles drops below that which is navigable by some important fish species. This low 
flow threshold can be used to determine the frequency and duration of low flow events, and 
even the average minimum flow of each event. In addition to the user defined threshold, a 
threshold can be defined in terms of the mean daily flow. By defining flow thresholds in terms 
of some intrinsic factor of the flow record the same spell analysis may be applied to several 
flow records to help interpret differences in the flow regime. 

Low Flow Spell Analysis Example 

• Imagine that the spawning of some native fish species in Australia occurs during 
periods of stable low flows where water velocities and depths are low and temporally 
stable. This same period of low flow happens to be the time of peak demand for 
irrigation water to be delivered down the stream. The frequency and duration of the 
low flow periods could be compared between the natural low flow regime and a 
synthetic flow regime proposed by the irrigation facility. 

• Consider the position of the irrigation facility in the example above:- Are we confident 
that it is the stable low flows that facilitates species spawning and recruitment?  This 
hypothesis may be tested by comparing a long data set of temporally collected 
recruitment data with detailed spell analysis of the flow record over the same period. 
Do periods of high recruitment follow periods of low flow? 

5.7.2 High Flow Spell Analysis 

The High flow Spell Analysis is conducted in exactly the same manner as the Low Flow Spell 
Analysis, however it the frequency, duration and magnitude of events above the threshold 
that is important in this case. 
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High Flow Spell Analysis Example 

• Fluvial Geomorphologists (those that describe the evolution of the landscape by 
water) have dedicated considerable attention to describing "channel forming flows". 
That is those flows with the capacity to transport sediment and reform the channel. 
One can consider not only the frequency of such flows (as described in flood 
frequency analysis) but also the duration that is critical to being able to do work on 
the stream. 

• Consider a small hydroelectric power plant that discharge near bankfull flow when 
operating at peak discharge. If this discharge corresponds to that required to 
transport sediment, then the management of the power station may be required to no 
increase the rate of sediment transport due to the operation of the power plant. To 
address this problem one may compare the high Flow Spell analysis of the natural 
hydrograph with that of a modified hydrograph due to power generation. 

5.7.3 Reported Values 

Number 

The number of spells for the reporting period. The reporting period can be the whole record, 
annual, seasonal or monthly, see the advanced options section. 

Average duration 

The average duration of spells for the reporting period.  

Single Longest 

The single longest spell during the reporting period. 

Total duration 

The total duration of spells for the reporting period. 

Magnitude 

The mean peak for high spells or minima for low spells is reported.  

Period Between 

The mean of the period of time between spells.  

5.7.4 Threshold 

The threshold flow (above or equal to which a high flow spell commences, or below which or 
equal to which a low spell commences) can be selected using several alternative criteria: 

• Mean daily flow: A number of mean daily flows (can be a decimal) 

• Standard deviation: The mean daily flow plus some number of standard deviations of 
the daily flow 

• Percentile: a percentile of the daily flow, for example the 10th percentile flow is that 
flow which is exceeded 10% of the time. 
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• User defined: and user defined flow value. The Hydraulic Analysis module can be 
used to determine the appropriate user defined threshold level. For example this may 
be the discharge at which benches become inundated, or riffles have adequate depth 
of flow to allow fish passage. 

5.7.5 Independence Criteria 

Independence criteria determines if spells above or below a threshold (defined above) are 
separate events or part of the same event. Where consecutive spell events are not deemed to 
be independent, their duration is simply added. Two alternative independence criteria are 
available; 

1 Number of days between spells: the number of days between the last day of an event 
and the start day of the next event. 

2 Number of days between peaks: the number of days between event peaks. 

How TSA handles overlapping spells between time periods 

When analysing annual, seasonal or monthly time periods, it is necessary to know if we are 
in an event at the end of the time period. TSA records this information and considers it for the 
start of the next period. The occurrence of the event is recorded for the period in which it 
began, however the length is recorded in whichever period it occurs. If a spell starts in one 
period and ends in another (e.g. a flood that spans the December 31 and January 1) the 
occurrence of the spell is recorded for the first period, and the duration of above spell 
periods is attributed to the year in which it occurs. It is therefore possible to have a year when 
the only spell is one that spans from the end of the preceding year, in this case there will be 
no spell in the year, but there will be a spell duration recorded for the year. TSA also 
compares independence criteria between analysis periods. That is the number of days 
between peaks or the end and start of spells can span the end of an analysis period without 
affecting the output. 

5.8 Base Flow Analysis 

 

 Figure 5-18:  Base flow analysis input screen   

Base Flow is considered here to be that flow which occurs in the absence of runoff due to 
rainfall events. A hydrograph will generally have long periods of relatively consistent low flow 
when the stream is groundwater fed interspersed with periods of high flow due to storm 
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events (see figure). The purpose of base flow analysis is to divide the hydrograph into the 
base flow and flood flow component parts.  

Base Flow Analysis Example 

• The Base Flow may be considered to be important for the establishment of 
macrophyte beds on which algae grow and which is subsequently harvested by 
macroinvertebrates. Two alternative irrigation schemes are being considered, one is 
based on water extraction whenever needed, the other is based on "harvesting" 
floodplain flows. The impact of the two irrigation techniques on the base flow can be 
assessed by examining the alternative effect on the base flows. The scheme with the 
least impact on the development on macrophyte beds can be adopted. 

• Consider the assumption of the previous example that base flows are important for 
the establishment of macrophyte beds. This hypothesis can be tested by comparing 
the macrophytes and base flow of several similar streams. 

5.8.1 Base Flow Method 

The method of calculating the base flow component of the hydrograph is through the use a 3 
way digital filter as described in (Grayson et al., 1996). The purpose of the digital filters is to 
create a relatively smooth transition from the period of base flow before a storm event to the 
usually elevated base flow following the storm event. In practice there is no way to accurately 
describe the base flow during periods of runoff, however Lyn and Holick method is generally 
accepted as a suitable approximation (Grayson et al., 1996). 

Base flow index 

The base flow index is the ratio of total base flow discharge for the reporting period to total 
discharge. 

Flood flow index 

The Flood flow index is the ratio of non-base flow (discharge – base flow) and total 
discharge. The intention of the flood flow index is to provide an indication of the likely 
proportion of discharge from overland flow. 

Mean daily base flow 

The daily base flow is calculated as the total base flow component of the hydrograph divided 
by the number of days of the record. 

Base flow time series plot 

A plot of the base flow time series is placed on the Input plot after running the analysis. The 
base flow time series can be analysed just like any other time series to detect patterns such as 
seasonality.  
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5.9 Rises and falls 

 

  Figure 5-19:  Rates of rise and fall   

The rate of rise and fall of the hydrograph could be particularly relevant for cases such as;  

• fish that use flow as triggers for migration and spawning,  

• The ‘intensity’ of a flood disturbance (i.e. the rate of discharge increase) may affect 
how fish species respond and seek refuge. 

• rooted, floating macrophytes that rely on relatively constant water levels, 

• Benthic metabolism that relies on photosynthesis of algae attached to the substrate is 
highly influenced by water depth in turbid rivers.  

The rates of rise and fall calculations are done by comparing the values of consecutive days, 
to determine if discharge is increasing, decreasing or constant. 

Mean magnitude 

The mean magnitude is the average of the total change in discharge for all rises or falls for 
the period of analysis. For example a rise may occur over several days, the rise of each day is 
added together to provide a total rise for that rising event, the total of all these rises for the 
analysis period is computed and divided by the number of rising events. 

Mean duration 

Periods of rise and fall could occur over a single day or could go for months for the receding 
limb of a flood on a big river. The mean duration is the addition of the duration of all rises or 
falls for the analysis period divided by the number of rises or falls. 

Total duration 

The total duration is simply the addition of all days of rising or falling flows for the analysis 
period. 

Mean rate 

For each rise or fall event the rate is the change in discharge for the event divided by the 
length of the event, the result is usually in Ml/d/d (depending on the units for the input). The 
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mean rate is the addition of all the rates for all rises or falls divided by the number of rises or 
falls. 

Single greatest rate 

The single greatest rate of rise or fall is the largest rate of discharge change. 

5.10 Haines Seasonality measure 

 

  Figure 5-20:  Haines input screen   

Not implemented for RAP TV1.0.0 

5.11 Wettest versus driest years 

 

  Figure 5-21:  Wettest vs driest input screen  

Not implemented for RAP V1.0.0 
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5.12 Output Table 

 

 Figure 5-22: Output Table  

Once statistics have been selected and the run button pressed, the result are displayed in the 
output table. You can navigate around the output table using the scroll bar on the right and 
resize rows and columns by selecting and dragging at the boundaries of the columns and 
rows. The output table can be saved as a .csv file.  

5.13 Output Visualisation 

 

 Figure 5-23:Output visualisation screen  

In addition to the tabular output in the output table, the output for annual, seasonal and 
monthly is plotted to visualisation plots. These plots give you the opportunity to view at a 
glance how particular statistics vary through time. An example may be to compare the mean 
monthly discharge through time for alternate modelled flow scenarios. You can zoom into 
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the plots by right clicking with the mouse, select zoom, then left click with the mouse and 
drag a square over the area of interest. To zoom back out simply right click the mouse 
button. You can pan by right clicking select pan, then dragging the mouse back and forward 
while holding down the left mouse button to scroll through the record.  

5.13.1 Flow Duration Curves 

 

 Figure 5-24:Flow Duration curves   

Flow duration curves are an interesting way to visualise the difference in flow patterns 
between streams or comparing different times. Flow duration curves for the whole record, 
years, seasons and months are plotted. You can see how the summer flow pattern differs 
from the winter due to the shape of the flow duration curve. 

5.13.2 Flood Frequency 

Flood frequency plots are not featured in RAPV1.0.0 
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